Лабораторна робота №5.
РОЗРОБКА СИСТЕМИ НЕЧІТКОГО ВИВОДУ В ІНТЕРАКТИВНОМУ РЕЖИМІ.
1. Розглянемо розробку системи нечіткого виводу на прикладі «Чайові в ресторані»:
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2. Методика виконання завдання
1. Запустити Fuzzy Logic Toolbox за допомогою команди «fuzzy».
2. Додати другу вхідну лінгвістичну змінну за допомогою меню «Edit → Add Variable → Input» (рис. 2.1):
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Рис. 2.1. Додавання лінгвістичної змінної

2. Відредагувати параметри функцій приналежності відповідно до умов завдання (рис. 2.2).
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Рис. 2.2. Налаштування параметрів функції приналежності

3. Сформулювати набір правил (рис. 2.3).
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Рис. 2.3. Вікно редактора правил
4. Розглянути результати моделювання механізму прийняття рішень за допомогою меню «View → Rules» (рис. 2.4).
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Рис. 2.4. Вікно результатів моделювання

[bookmark: _Hlk135916155]Наприкінці лабораторної роботи необхідно проаналізувати результати і зробити висновок.

Приклад висновку:
Досліджено програмний продукт Matlab та пакет математичного моделювання Fuzzy Toolbox у ньому. Набуто більш глибоких знань щодо нечіткої логіки та механізмів прийняття рішень на її основі. Для виконання всіх завдань з нечіткої логіки використовувалися 3 функції приналежності – трапецієподібна, Гауса та трикутна. Ці функції були використані для передачі можливостей методу експертних думок.
Наприклад, для рівня води було обрано три функції Гауса для трьох параметрів нечіткої логіки у другому завданні для очікуваного рівня води, а для всіх інших комбінування трапецієподібної та трикутної. Таким чином можна легше передати різні параметри нечіткої логіки для всіх завдань.
[bookmark: _Toc156832221][bookmark: _Toc135830251]3. Порядок виконання роботи
1) Здійсніть вибір функцій приналежності, використовуючи метод експертних оцінок (варіанти завдання наведено у Додатку А).
2) Побудуйте базу правил за допомогою вибраних функцій приналежності. Реалізовану базу правил відобразіть у звіті в табличному вигляді за зразком таблиці 2.1.
Визначаємо всі правила, із зазначенням відповідних значень нечітких змінних x, y і z, та заповнюємо таблицю на прикладі таблиці 2.1:
Таблиця 2.1
База правил
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[bookmark: _Hlk134554517]3) Промоделюйте механізм нечіткого логічного виведення за допомогою пакету прикладних програм Matlab.
4) Відобразіть результати роботи в звіті.
5) Підготуйте відповіді на контрольні запитання.
[bookmark: _Toc156832222][bookmark: _Toc135830252]4. Вимоги до звіту
Звіт подається в електронному вигляді. 
Звіт повинен містити такі результати:
1) Опис сформульованих правил логічного висновку у табличній формі. 
2) Скріншоти (знімки екранів) графіків функцій приналежності, бази правил та результатів моделювання. 
3) Короткі висновки з виконаної роботи (з оцінкою ефективності розглянутих методів).
[bookmark: _Toc156832223][bookmark: _Toc135830253]2.3.3. Контрольні запитання
1) Вкажіть відмінності нечіткої змінної від лінгвістичної змінної. 
2) Наведіть основні типи функцій приналежності. 
3) Опишіть основні етапи нечіткого логічного виведення з використанням методу max/min. 
4) У чому полягає суть етапу дефаззифікації? 
5) Назвіть основні переваги нечітких алгоритмів прийняття рішень.
[bookmark: _Toc156832225][bookmark: _Toc135830261]Додаток А. Варіанти завдання

Варіант 1
1.1
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Середня заробітна плата клієнта
y – Тривалість роботи на останньому місці
	z – ступінь фінансової довіри



1.2
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Вік
y – Соціальний статус
	z – Ступінь соціальної довіри



1.3
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Ступінь фінансової довіри
y – Ступінь соціальної довіри
	z – Максимальна сума споживчого кредиту



Вариант 2
2.1
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Рівень опадів
y – Середньодобова температура
	z – Швидкість танення снігового покриву



2.2
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Максимальний очікуваний рівень води у водосховищі
y – Площа басейну водосховища
	z – Обсяг спуску води



2.3
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Швидкість танення снігового покриву
y – Обсяг спуску води
	z – Очікуваний рівень повені



Вариант 3.
3.1
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Якість сценарію
y – Якість гри акторів
	z – Якість режисерської роботи



3.2
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Бюджет фільму
y – Рівень спецефектів
	z – Видовищність фільму



3.3
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Якість режисерської роботи
y – Видовищність фільму
	z – Розмір касових зборів фільму



Вариант 4.
4.1
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	х – Якість викладання
y – Якість лабораторно-методичної бази
	z – Якість освітнього процесу



4.2
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Рівень мотивації студента
y – Ступінь винахідливості студента
	z – Середня успішність студента





4.3
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Якість освітнього процесу
y – Середня успішність студента
	z – Рівень засвоєння знань



Вариант 5
5.1
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Рівень фінансових вкладень
y – Термін окупності проекту
	z – Ступінь ефективності інвестицій



5.2
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Кваліфікація персоналу
y – Якість матеріальної бази
	z – Якість виконаних робіт



5.3
	Вхідні лінгвістичні змінні
	Вихідна лінгвістична змінна

	x – Ступінь ефективності інвестицій
y – Якість виконаних робіт
	z – Ефективність проекту
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Tpadiunmit inTepeiic OPOrpaMH OPOFIATAHHA NOBEPXH| HCUITKOrO BHBCICHHA T4 PO3POBICHO
HewiTxof MoeTi 305pakermit Ha Ma1. O.

Llx OporpaMa CIYKHTS 111 3AraTbHOTO AHATIY ATCKBATHOCTI HEWITKOI MOJT, 103BOLTONH OUIHETH
BITHB 3MiHH 3HaUCHb BXITHNX HESITRIX SMIHHNX HA SHQUCHHS OTHiel 3 BUXITHIX RewiTirx ayimmux. V pasi
HoTpedH MoHa oTpmMaTH rpadik 3ateAmOCT BEXitHOY 3MimHOI BiX Oamiel 3 BXiTHEX aMimHmx. [[12 mBOrO
HeOGXiTHO BHOPATH MOTPIGHY 3MIHHY B CHICKY. Mo posxpBacTsca. X (input). a » cmicky Y (input). mo
POSKPHBAETBCA. BHOpATH 3HaucHEA -nonc-. OTpmianmil rpadix satexmocti sobpaxemmii ma Ma1 10.
Otprvarmii rpadik 3aTCKHOCT] BIINOBIIAE CEpEAHBOMY FHAUCHHIO APYToi BXITHOI 3MiHHOI ("akicmb eeuepi”)
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B 5 Gazis. Lle 3HAYCHHA Moxe GYTH 3MiHEHE KOPHCTYBATEM, [UTA WOTO CIiT BBECTH MOTPIGHE 3HAUCHHA B IIOTE
spexcna Ref. Input:. Binvininvo, mo suaverns NAN 11s nepmoi pxizHoi sinmof simosizac & syini y
Bebosy inTepsani susmavenns [0.10].

o ven comrs

Prc. 9. Bi NOTPaMI Ieperaty HOBEPXHI HEITKOTO BUBCACHEA A7 PO3POCICHOT HETITROI MOZETi.
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3AKIFUYIOT POIFTAT TPOUCEY POIPOGKA TPOCTO] CHETEMT HESITKOTO BHBGICHHA B IHTCPAKTHBHOMY
PORMML ST BITITHTH, Mo HAROUTSI cQEKTHBAINM Hell COGIS BEABIACTEA AT CKTATHIX HOTITRIX
MOCTeH 3 BETHKIN WHCTON IMIFFS | NABAT ACYITKOFO BHBCICHHA, B IBOMY BHNATKY 3ABIARFA SMIRATIX i
YARTIi IPARATCAHOCTI £X TepMiB B TPAGITHONY PEKIMi, 4 TAKOK BiSYATI3ANIA IPABAT T03BOTAOTE iCTOTHO
3VCHITHTH TPYTOMICTRICTS POIPOGKA HEWITKO] MO, KLTSKICTS MOAKTHBI TOMATOK i CROPOTHTH 3ATAToRTI
9AC ACTITROTO MOACTIOBARTA.

Fie g3t von Optens
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Pric. 10.Tpadix 3a7CKROCT: BARLTHOT SMIRFHOT B1 TGP0 13 BXLTHITR SMIRFITK T4 PO3POSTIeHOT AeiTROT
sozemi

V Toi Wac c7iT MAMATATH, Mo KITSKICTH SMIRFNYX i MPABAT B HEWTKi MoZeT. AKI MOEYTS GyTH
BisyaTizosari, oGMeKeHa. 30KpeMA, AKIO WHCTO BXLIEX S\GAFHX mepesmmye 10, To iX BiToSpAKCHEA ¥
BiTMOBLAIX rpadiTHI PEIAKTOPAX BIIOYBAETECA 13 BITXHICHRAMI.

Tlporice PospoBKI CHCTEMT HTITKOTO BHBGICHRA B PEKINMi KOMART MOKC IOTIOBRWTH. @ B OKEMIK
BNTATKAX. | SAMIRHTH TpOTCC POIPOCKH B IRTCPAKTHBROMY PEAWMI HATRIOWH KOPHCTYBAUCHi TOBHI
KOHTPOJTb HAZ BCMa SMIHHIMI podouoMy o61acti cneresu MATLAB.
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Sk NpEKTAX PO3POGKH CHETEMH HETITKOTO BHBOIATN B IHTCPAKTHBHOMY PEXHM 3 ZONOMOTOR
rpadiurmx 3acoéis makery Fuzzy Logic Toolbox posrifseno HACTYMHY HEWITKy MOASTb, AKA BXOZHTS X0
HCTA TeMOHCTpAUifiHmX mpHkTatis ccrema MATLAB.

Mpuxaax. "Yaiosi 6 pecmopari”. PosTIARe o CHTyalio B pecTopaRi, IpH AKill, 3ridHo mpmitamn i
CIIA Tpazamisny, mic1s 3aKiHUCHAA OGCTYTOBYBAHAA BiTBiAyBata NPUIRATO 3ATHIATH oiliaRTOBI HalioBi.
TpyHTyloMHCS Ha CTATHX B Wilf kpaimi 3BHYAAX i IRTYITHBHEX NPECTABICHAAX BLBIZyBatis pecTopais
BEMIMIHA CyMH WaliOBHX He € MOCTIHiHOK i 3ATCANTH, HANPHKTAL Bil AKOCTi OGCIYTOBYBAHEHA i AKOCTI
MPHrOTYBAHHA 32MOBISHIX OO

3aBaHHA TOTATAE B TOMY. 06 POPOGHTH TeAKY EKCTIRPTHY CHCTeMY, AKa 6y1a 6 peaTisosana y BuTIATi
CHCTEMI HEWITKOro BEBOZY i 103BOMIATa G BHIHAYATH BEMIMHHY WalOBHX Ha OCHOBI CYO'€KTHBHIX OLIHOK
BiABiTYBAYiE AKOCTi OGCTYTOBYBAHEA | KOCT] IPHTOTYBAHAA 3aMOBICHAX OI0L.

EMIIpHUH| 3HAHAT IPo IAHY POGIEMEY 0GIaCTs MOKYTH GYTH OpeIcTapiecri y (Gopyi HACTYHHX
©BPHCTHNHNX IPABHI TPOAYKII:

L.Slxmo oGeayrosysansa Horane abo Beseps NLArOpia, T0 Taliopi - Mazi.

2.SIxmo obeayrorysani 200pe. T0 Haiion - cepexni

3.5IKImo 06CTYTOBYBAHHA BLTMIHHE a60 Bedeps TyI0BA. TO HalioBi - meIpi.

Hpuviria: TIprsciesi BAme NpABATA AiffcHo CyO'eKTHBHI | A sBiThHCHI Bix KpATHKA. 3oKpeNa, T14
SAraTEOX BLTBLTYBAUIS HATIA PECTOPAFIS MOKe IOKA3ATACH THBHANM TPABHTO 1. IriTHO AKOMY CTLT ATHITATH
“affoBi Y pasi IOTAROTO 0OCTYTOBYBARFA 460 BECPi, Mo TLArOpiTa, i MPABITO 2, STiTHO AKOMY LT SATHITATH
cepeTHi walfoBi HaBiTh ¥ pasi Bewcpi, Mo MiAropiTa. MoTHB0, JeAKi 3 THTAWS BHSHAIOTS MOKTHBAM B3arai
BITMOBHTHCA BiT SATHICHEA WaHOBNX B TOTIOREX CHTYANIAX i OYIyTs Mo cBOEMy Mari pamiro. Ilpote.
OCKITHKI JAMHH MPAKTAT MHPOKO BHKOPACTOBYETECA & TiMepamypi ATA ACMORCTPATI] MOKTHBOCTSH CHICTENT
MATLAB. Bisi IPHBOHTHCA TYT G¢3 3MIHH B CBOEMY OPHTHATBHOMY BHITALL.

SIX BXITHI NQPAMCTPH CHCTEMH HEWiTKOTO BEBOIY POSTIATaTHMeMo 2 HewiTki JimTBicTHumi syimmi
“aicmy obc1veoayeanns” i "sxicmis npuzomysanta savosrenux cmpas” (a5o cxopoteso - "axicmis seuepi”).
AX BUXITHI NAPaMCTPH — HeWiTKY THTBiCTINEY 3MiHY "senuNuHA YaiioBUX'

B AKOCTi TCPM-MHOXENE ICpWON  IiHIBCTHUHON  SMiEHOWO  'skiomb  obe1veosyeans”
BuKopHcTOBYBaTIMeNO MEORHHY Ty={"N0zane”, “Oo6pe”, “sidMine”}. a B AKOCTI TepM-MHOXUHH Apyroi
isrBicTITRO] SOl “skicms euepi” BHKopuSToByBTINENQ oKUKy Ty={ “nidcopinuil”, “woosui’}. B
ANOCT TepAI-MHO AN BHSiHOT TATBICTIROT SMiFHO "6eTUMIHA HaloGLY  BUKOPHETOBYBATINENO MAOKNEY
Ts={wani”, “cepedni”, “ujedpi”}. Tlpm mboMy Koen 3 Tepitis mepmoi i Apyroi BXiTHOT IMimHO (aKicTs
05CTYToBYBAREA | NPHFOTYBAHHA 3aMOBICHAX CTPaB) OLIRIOBATHMENMO 33 10-5aTbHOK HOPATKOBOM MKATOM,
‘p axiit mrchpi O BiIMOBiTA AKHAHTIpIIA omiKa, a mdpi 10 — AKHafikpama omizxa. ILo CTOCYETBCA TEpMIB
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BHXUIHHH 3MIHHOL TO NPHIOYCKATHMEMO, IO Maml YaHOBI CKIATAKTh OMH3BKO 3% BII BaPTOCTI 3aMOBICHHX
CTpas. cepeani watiosi — 6:1m3bK0 15%, a mepi watiosi - G1uzbKO 25%.

3 YPAXYBAHAAM 3pOGICHEN YTOUHCHS, POSTIAHYTA CYO'eKTHBHA IHQOpMAIiA Mpo BETIEY HaifoBmX
Mose GYTH npeIcTaBIeHa y Gopi 3-X NPABIT HEUTKIX NPOAYKIi HACTYTHOTo BUr1ATy (CHCTeM HEUiTKOrO

Tlpasmo_L: SIKIIO "sxicms obcayeosysarins nozana” ABO "seveps nideopina”
TO "eenusuna uaiiosux sara”
SIKILO "sxicmw o6enyzosysantia xopouua”
TO "eenusuna uaiiosux cepedrs”
Tlpasiuo_3: SIKILIO "sxicmib obenyzosysantia sidaiisna” ABO "seveps cuauna”
TO "semriuna waiiostx wedpa”

TIpasmro_

Tlpomec pospodKH CHCTEMH HEWITKOTO BHBOTY B iHTCPAKTHBHOMY PEAINMI 111 poSTITHYToro smme
npuxtazy "Yailosi 6 pecmopani” IoIATaE y BUKOHAHA] HACTYIHOY MOCTLIOBROCTI ii:

1.BHKTHKATH PeIAKTOp CHCTEM HewiTkoro smeexcrms FIS, 111 woro y Bikmi KoMam: HadpaTa iMa
sianosianoi gymknii fuzzy. Tlicn BHKOHaHNA Wiei KOMAMTH Ha ekpami 3ABHTRCA TpadiTmmit inTepdeitc
penaxtopa FIS 3 im'am cucTemm Heuitkoro suBeacHma Untitled i THIOM CHCTEMH HEWITKOTO BHBEACHHA
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(MaMaR]) 3ATPOTOROBAKTNMI 32 YMOBYAREAN .

2.0cKiToRE B OPEKTATI POSTIAIAETBCA CHCTEMa HEWUITKOFO BHBCICHHA 3 IBOMA BXOTAMI, HEOGXiTHO
Zozata B cuctemy FIS, mo pospodnacTbes. me oIdy BXiTHY 3MinHY. JLIA UBOTO CIil BHKOHATH KOMAHIY
semro Edit>Add Variable.>Input. B pesyTsTari puxoamss miel KoMAHIH Ha TiarpaMi CHCTCMI HOWITKOro
BHBeCHAA 3 ABHTHCA HOBMUIH KOBTHI IPAMOKYTHEK 3 iM'M Apyroi BXiTHof sMinmof: input2 (vax. 1).
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Maa. 1. Bux pexaxropa FIS micas Zoasamas apyrof sMimsof

3.3vimmio iMeHa BXLTHIX | BUXLTHIX 3MIHHIIX, 3a0pONOROBAHEX cueTeMoto MATLAB 32 yoBYaHERL.
112 Tboro HeoGXiTHO BHALTATH NPAMOKYTHAK 3 iM'AM BLlIOBLTHOT 3MiHHOL BHKOHABIN KTaUAEA Ha fioro
306paxeHHi Ha diarpavi (CTOPOHH BHITCHOTO OPAMOKYTHIXA MAKTh uepommii xoaip). Iliewa woro erix

HaGpaTH HOBe 7 3MIRHOI B TOTi BBecHAA Name  Tpasiit wacTimi peaaxtopa FIS. PesyTsTat syimm ives
AMIHHEX CHCTEMH HEUITKOTO BHBEICHHT 300DaKeHI Ha MaT. 2.
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Max. 2. Bux pezatopa FIS micas 3MIHH DMeH 3MIHHIX, 3a0poNoROBAREX crcTenoto MATLAB 3a
yMOBUAREAM

Tpmyitka
11106 YRRKFYTH MPOSTEM 3 KOPEKTHAM BITOGPAKCHAAM CHMBOTIS KAPITHII. CTiT IaBaTH Taxi iema
SVGHATIM, AKi CKTATAIOTECA 3 OTHOTO G708} 663 TOTATROBIX CTYKSOBHK CHMBOTE.
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4.3y infx creTesm HewiTkoro suseaenn (Untitled), sanporonosare sa yvoswasmm. Iz wworo
sepesento cTBoprosay cTpyKTypy FIS B 30mimmpoMy Gaiiai 3 ixa mytip.fis, BUKORABIIT KoMAHIY Metio
File>Export>To Disk.... Tlpn msovy 6ye BUKTHAHO CTAHIGpTHE AiaTorose Bikwo soepexemx daitry.
AXOMY KOPHCTYBAUCBi TIPOTIORYETheA BBECTH ‘s BLIoBLIROr0 daiity (posmuperna Gailly MpHAHCYeTsca
aBToMaTHIHO). 3ATHIIIMO Ge3 3MIHH 3anPONOHOBaK] crcTeMo10 MATLAB 32 YMOBYGHHAM: METOA HETITKOTO
oriasoro I (And method) — sHaucsms "min". MeTox meuirxoro foriuHoro ABO (Or method) savemma
"max", Metox iumrixanii (Implication)— sHatuenns "min”. MeTox arperanii (Aggregation) sravenna "max” i
Metox edasudixanii (Defuzzification) sHaucrmua "centroid”. OUCBIIHO, 1i JHAUCHAA MOAKYTS OyTH incri
KOpHCTYBaueM.

5.Tencp HeoBXiTHO BH3HAUNTH TepMH i i pyHNII OPHATEKHOCTI 177 BXITHIX | BUXITHIX sMiHHIX
Hamoi cHCTeMH HeWiTkoro BuBexeHss. 1A UBOTO CIiA CKOPHCTATHOA PEIAKTOPOM GYHKIiH IPHEATEAHOCTI,
At Moe GyTH BUKTHKAHIE OTHIN 3 HACTYTIHIX CIOCOG:

+ MoBIiHAN KIANAHAAM Ha SHATKY IPAMOKYTHNKA 3 I'AM BiTHOBiTHOT sMiHHO:

+ xoMarz010 Memmo Edit>Membership Functions... (3a3a1erits nopuses 5yTH BUIUTCHII IPAMOKYTHIX
3 ix'mt pimoBitsof syinHoi)

+ HaTHCHemAAM K1aBim <Ctrl>+<2> (3337A7CriT TaKoK IOBHHCH GYTH BIIIICHII IPAMOKYTHAK 3 B/
Biamosiasof simmoi).

ITic1 BIKTHKY peaaKTOpa GyHKUii IPHHATEKHOCT] KOXHil i3 3MIHHIX 32 YMOBUAHHAM NPOTOHYETBEA 3
TepMH 3 TPHKYTHEME GYHKIII IPHEATCKHOCT] (MaT. 3.).





